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Abstract 

Biosurfactants have remarkable characteristics, such as environmental friendliness, high safety, and excellent biodegradability. 
Surfactin is one of the best-known biosurfactants produced by Bacillus subtilis. Because the biosynthetic pathways of biosurfactants, 
such as surfactin, are complex, mutagenesis is a useful alternative to typical metabolic engineering approaches for developing high- 
yield strains. Therefore, there is a need for high-throughput and accurate screening methods for high-yield strains derived from 
mutant libraries. The blood agar lysis method, which takes advantage of the hemolytic activity of biosurfactants, is one way of deter-
mining their concentration. This method includes inoculating microbial cells onto blood-containing agar plates, and biosurfactant 
production is assessed based on the size of the hemolytic zone formed around each colony. Challenges with the blood agar lysis 
method include low experimental reproducibility and a lack of established protocols for high-throughput screening. Therefore, in 
this study, we investigated the effects of the inoculation procedure and media composition on the formation of hemolytic zones. We 
also developed a workflow to evaluate the number of colonies using robotics. The results revealed that by arranging colonies at 
appropriate intervals and measuring the areas of colonies and hemolytic rings using image analysis software, it was possible to accu-
rately compare the hemolytic activity among several colonies. Although the use of the blood agar lysis method for screening is 
limited to surfactants exhibiting hemolytic activity, it is believed that by considering the insights gained from this study, it can con-
tribute to the accurate screening of strains with high productivity.
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Introduction
Bacillus spp. produce a variety of biosurfactants [1, 2]. 

Biosurfactants are predicted to be the next-generation surfac-

tants because they are safer and more biodegradable than 

petroleum-derived surfactants, resulting in a lower ecological 

impact. They have broad applications in detergents, cosmetics, 

and pesticides [3]. Therefore, the development of high- 

production biosurfactant processes as well as the construction of 

high-production strains are needed. Notable biosurfactants pro-

duced by Bacillus spp. include surfactin, plipastatin, and iturin, 

all of which are nonribosomal peptides (NRPs) [4–6]. These bio-

surfactants are produced through the sequential condensation of 

fatty acids and amino acids on large modularized proteins, such 

as NRP synthetase.
Metabolic engineering approaches and mutagenesis have 

been explored as ways to produce high levels of biosurfactant in 

Bacillus spp. It is challenging to improve NRP synthesis using only 

metabolic engineering techniques that require enhancing 

multiple amino acid and fatty acid production pathways, disrupt-
ing competing pathways, and increasing the expression of func-
tional NRP synthetase. Therefore, approaches such as obtaining 
high-production strains from mutants exposed to UV radiation 
or chemicals have been used [7, 8].

Various methods have been developed to investigate the pro-
duction of biosurfactants by microorganisms [9, 10]. There are 
two major methods for evaluating the production of biosurfac-
tants. One involves the detection of biosurfactants contained in 
the culture supernatant after liquid cultivation of microorgan-
isms, and the other is to directly detect biosurfactants produced 
by colonies on agar plates.

Methods such as oil spread, drop collapse, and the colorimet-
ric assay can be used to evaluate the quantity of biosurfactants 
in the culture supernatant. The oil spreading method involves 
spotting the culture on an oil film formed on water to determine 
the size of the displaced oil circle, which represents the amount 
of biosurfactant [11–13]. The drop collapse method determines 
the amount of biosurfactant by dropping the culture into oil- 
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coated wells and observing the collapse and spread of liquid 
droplets [11, 14]. Both methods require complex steps, such as 
dropping oil, which makes them unsuitable for evaluating multi-
ple samples. The colorimetric assay has previously provided an 
accurate quantification of surfactin and other lipopeptides using 
various dyes [15–17]. For example, bromothymol blue, Victoria 
pure blue BO, and polydiacetylene have been used as dyes. In ei-
ther of the above-mentioned dyes, the change in color resulting 
from the addition of culture supernatant to microtiter plates con-
taining the dye is measured using a plate reader to quantify the 
biosurfactants by absorbance.

The atomized oil assay, ion-pair plate assay, and blood agar 
lysis methods are used to detect biosurfactants produced by colo-
nies on plates. The plate assay method is very effective as a pri-
mary screening technique because it does not require liquid 
cultivation; instead, colonies are grown on agar plates, thereby 
making it easy to operate. In the oil-misting method, oil is 
sprayed onto colonies on agar plates using an airbrush [18, 19]. 
The size of the halo that forms around the colony can be used to 
semi-quantitatively evaluate the amount of biosurfactants. A 
drawback is the inability to visualize the halo until oil is sprayed. 
In the ion-pair plate assay method, microorganisms are inocu-
lated onto plates containing methylene blue derivatives [20]. The 
semi-quantitative evaluation of the amount of biosurfactants is 
possible through the dark blue halo surrounding the colonies. 
This technique allows for the detection of anionic biosurfactants. 
However, the growth of B. subtilis was reportedly inhibited by 
methylene blue derivatives. The blood agar lysis method involves 
inoculating microbial cells onto blood-containing agar plates and 
measuring the size of the hemolytic zone around the colonies to 
determine the amount of biosurfactant [7, 21]. The blood agar 
lysis method can only be used with biosurfactants that exhibit 
hemolytic activity. However, this method has an advantage as 
the hemolytic zone is clearly visible, which aids in area measure-
ment, and temporal changes in the hemolytic zone can also be 
observed, thereby allowing the measurement of hemolytic activ-
ity at the appropriate timing.

Moreover, the blood agar lysis method has been used to screen 
for B. subtilis mutants with increased surfactin production [8, 21]. 
Challenges with the blood agar lysis method include low experi-
mental reproducibility and a lack of established protocols for 
high-throughput screening. Therefore, it is currently difficult to 
evaluate a large number such as tens of thousands of colonies. In 
the blood agar lysis method, the formation of hemolytic zones is 
strongly influenced by factors, such as medium composition, cul-
tivation period, and manual techniques, all of which provide 
obstacles to reproducibility (data accuracy) during multi-sample 
processing. Therefore, in this study, we thoroughly investigated 
the factors influencing colony and hemolytic zone formation and 
incorporated them into the operating conditions of an automated 
device. We established the feasibility of a screening system capa-
ble of simultaneously evaluating a large number of colonies for 
two structurally distinct biosurfactants: surfactin and 
mycosubtilin.

Materials and methods
Strain and cultivation conditions
Bacillus subtilis 168 (ATCC 23857) (168-strain) served as the host 
strain for biosurfactant production. Pre-cultivation was per-
formed in 1 ml of Luria-Bertani (LB) medium (10 g/l tryptone, 
5 g/l yeast extract, and 5 g/l NaCl) with appropriate antibiotics 
(5 μg/ml chloramphenicol, 5 μg/ml kanamycin, 100 μg/ml 

spectinomycin, and 0.5 μg/ml erythromycin) in a shaker incuba-
tor at 300 rpm and 37�C overnight. For surfactin production, 50 μl 
of pre-cultivation medium was inoculated in 2.5 ml production 
medium I [40 g/l soy flour, 5 g/l dipotassium hydrogen phosphate, 
0.5 g/l magnesium sulfate heptahydrate, 0.18 g/l calcium chloride 
dihydrate, 0.025 g/l iron (II) sulfate heptahydrate, 0.022 g/l man-
ganese (II) chloride tetrahydrate, and 30 g/l maltose monohy-
drate] and cultivated at 37�C and 300 rpm. To produce 
mycosubtilin, 12.5 μl of pre-cultivation medium was inoculated 
in 2.5 ml production medium II [40 g/l soy flour, 5 g/l dipotassium 
hydrogen phosphate, 0.5 g/l magnesium sulfate heptahydrate, 
0.18 g/l calcium chloride dihydrate, 0.025 g/l iron (II) sulfate hep-
tahydrate, and 0.022 g/l manganese (II) chloride tetrahydrate] 
and cultivated at 30�C and 300 rpm.

Bacillus subtilis transformation
Supplementary Table S1 shows all the primers used in this study. 
The B. subtilis transformation method has previously been de-
scribed [22]. The recombination scheme in this study is shown in 
Fig. S1. In this study, the introduction of genes was confirmed by 
PCR (Supplementary Fig. S1b) and sequence analysis.

To create a surfactin-producing strain, the 4-phosphopante-
theinyl transferase gene (lpa-14) from B. subtilis RB14 [23] was 
inserted into the sfp locus of the 168-strain via homologous re-
combination. This strain was named KB01. The lpa-14 integration 
cassette was constructed as follows: the up-homology arm, lpa- 
14, chloramphenicol resistance gene (cat), and down-homology 
arm were amplified from 168-strain genome, synthetic lpa-14, 
pDLT3 plasmid [24], and 168-strain genome by PCR using the 
sfpU-f1 and sfpU-r, lpa14-sfpU-f-2 and lpa14-cat-r-2, cat-f and 
cat-r, and sfpD-cat-f and sfpD-r1 primers. The four fragments 
were combined by overlap extension PCR using primers: sfpU-f2 
and sfpD-r2.

Bacillus subtilis ATCC6633 is a naturally occurring 
mycosbutilin-producing strain [25]. To transfer ATCC6633’s 
mycosbutilin operon (fenF-mycABC) to KB01, the kanamycin resis-
tance gene (kan) was inserted downstream of the mycosbutilin 
operon of ATCC6633. The kan integration cassette was con-
structed as follows: the up-homology arm, kan, and down- 
homology arm were amplified from ATCC6633 genome, pAPNCK 
[26], and ATCC6633 genome by PCR using the mycCU-f1 and 
mycCU-kan-r, kan-f and kan-T-tag-r, and mycCD-kan-f and 
mycaCD-r1 primers. The three fragments were combined by 
overlap extension PCR using primers mycCU-f2 and mycCD-r2. 
The KB01 strain was then transformed using genomic DNA 
extracted from the kan-integrated ATCC6633. The up-and-down 
sequences of the plipastatin operon (ppsABCDE) of the 168-strain 
and those of the mycosbutilin operon from ATCC6633 showed 
high sequence homology [27]. Therefore, the mycosbutilin op-
eron containing the kan from ATCC6633 was integrated into the 
plipastatin operon locus of the 168-strain using homologous re-
combination. This strain was named KB04. In KB04, DNA se-
quencing verified that the correct sequence of the mycosbutilin 
operon was inserted into the target locus of KB01. Finally, the 
surfactin operon was disrupted in KB04 by homologous recombi-
nation with the spectinomycin resistance gene (spec). This strain 
was named KB06. The surfactin operon disruption cassette was 
constructed as follows: the up-homology arm, spec, and down- 
homology arm were amplified from the 168-strain genome, pJL62 
[28], and 168-strain genome, respectively, using PCR with the 
srfABU-f1 and srfABU-spec-r, spec-f and spec-T-tag-r, and 
srfABD-spec-f and srfABD-r1 primers. The three fragments were 
combined by overlap extension PCR with primers srfABU-f2 and 
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srfABD-r2. To increase mycosbutilin production in KB06, the sur-
factin operon promoter was inserted before the mycosbutilin op-
eron. This strain was named KB07. The surfactin operon 
promoter cassette was constructed as follows: the up-homology 
arm, erythromycin resistance gene, surfactin operon promoter, 
and down-homology arm were amplified from the ATCC6633 ge-
nome, pMUTinHis [29], 168-strain genome, and ATCC6633 ge-
nome by PCR using primers mycU-f1 and mycU-erm-r, erm-f and 
erm-r, PsrfA-erm-f and PsrfA-fenF-r-2, and fenF-f and fenF6633- 
r1. The four fragments were combined by overlap extension PCR 
using the mycU-f2 and fenF-r2 primers.

Analysis of surfactin and mycosbutilin
The surfactin and mycosbutilin concentrations in the fermenta-
tion medium were analyzed using a high-performance liquid 
chromatograph (Shimadzu, Kyoto, Japan) equipped with an NPS 
ODS-IIIE column (4.6 mm × 33 mm, particle size 1.5 μm; Eprogen, 
Downers Grove, IL, USA). Analysis was performed using the fol-
lowing conditions: mobile phase, 0.1% (v/v) formic acid in water 
(A), and 0.1% (v/v) formic acid in acetonitrile (B). The flow rate 
was 0.7 ml/min with a gradient of 0–5 min (linear gradient from 
10% B to 51%); 5–20 min (maintaining at 51% B); 20–20.1 min (lin-
ear gradient from 51% B to 10%); and 20.1–35 min while maintain-
ing at 10% B (re-equilibrate); the injection volume was 10 μl and 
the column temperature was 40�C. Surfactin and mycosbutilin 
were detected by measuring the absorbance at a wavelength of 
205 nm using a UV detector.

Blood agar hemolysis method
Pre-cultivation was conducted in 3 ml of LB medium containing 
suitable antibiotics in a shaker incubator at 180 rpm and 37�C 
overnight. Pre-culture cells (100 μl) diluted 1.0 × 105 to 1.0 × 106 

times with sterilized water were plated onto NY agar plates [1 g/l 
nutrient broth (Becton, Dickinson and Company, Franklin Lakes, 
NJ, USA), 1 g/l yeast extract (Becton, Dickinson and Company), 
40 g/l glucose, 3 g/l NaCl, and 15 g/l agar (Becton, Dickinson and 
Company)]. The plates were incubated overnight at 37�C for col-
ony development. A blood agar plate was spotted with 2 μl of a 
single colony suspended in 50 μl of sterilized water for the hemo-
lysis assay. The blood agar contained the following ingredients: 
1 g/l nutrient broth (Becton, Dickinson, and Company), 1 g/l yeast 
extract (Becton, Dickinson, and Company), 40 g/l glucose, 3 g/l 
NaCl, 15 g/l agar (Becton, Dickinson, and Company), and 40 mL/L 
defibrinated sheep blood (Japan Bio Serum, Hiroshima, Japan). 
After spotting, plates were incubated at 35�C, and images were 
captured every 24 h.

Measurement of colony and hemolytic zone area
The colony and hemolytic zone areas were measured using 
ImageJ software (https://imagej.net/ij/index.html) [30, 31]. 
Images were separated into RGB channels using the commands 
(Image> Color> Split Channels) to calculate colony area. Using 
the red channel image, a threshold was established (Image>
Adjust> Threshold) to select colonies, and a binary image was 
generated. The colony area was measured using a command 
(Analyze> Analyze Particles). To clarify the limits of the hemo-
lytic zone for area measurement, the boundaries were 
highlighted (Process> Find Edges) before being separated into 
RGB channels. The hemolytic zone area was measured using a 
red channel following the same procedure as the colony area 
measurement. If adjacent hemolytic zones came into contact 
with the binary image, a command (Binary > Watershed) was 
used to separate them.

High-throughput screening with colony picker
High-throughput colony screening was carried out using the 
Qpix460 (Molecular Devices, LLC., San Jose, CA, USA) with a 96- 
pin-picking head (tip diameter: 0.5 mm, pin length: 49.5 mm). The 
pins were washed with 70% ethanol, water, and 10% bleach be-
fore and after picking. The picking colony was automatically se-
lected based on the following criteria: compactness (roundness) 
≥ 0.45, axis ratio ≥ 0.45, minimum diameter (mm) ≥ 0.50, maxi-
mum diameter (mm) ≤ 5.00, and minimum proximity (mm) 
≤0.45. A total of 48 colonies were inoculated on every other pin 
on each plate to maintain an appropriate distance between the 
B. subtilis colonies.

Results
Construction of biosurfactant-producing 
B. subtilis strains
The widely used B. subtilis 168-strain produces neither surfactin 
nor mycosubtilin. Although the 168-strain contains the surfactin 
operon, it is unable to produce surfactin due to a mutation in the 
4'-phosphopantetheinyl transferase gene (sfp), which is essential 
for the activation of the peptidyl carrier protein domain [32, 33]. 
As a result, lpa-14, a 4'-phosphopantetheinyl transferase gene 
obtained from the B. subtilis RB14 strain [23], was integrated into 
the genome of the 168-strain. The surfactin-producing strain was 
named KB01. KB01 yielded 5.5 ± 0.2 g/l of surfactin after 72 h of 
cultivation (Fig. 1a).

To produce mycosubtilin, the mycosubtilin operon from 
B. subtilis ATCC6633 was inserted into the KB01 strain’s genome. 
This strain KB04 can produce both mycosubtilin and surfactin. 
Therefore, the surfactin operon in KB04 was disrupted by replac-
ing it with a spectinomycin resistance gene, yielding KB06, which 
exclusively generated mycosubtilin. KB06 produced 39.8 ± 0.6 mg/ 
l of mycosubtilin after 72 h of cultivation (Fig. 1b). To increase 
mycosubtilin production in KB06, we changed the mycosubtilin 
operon promoter to a surfactin operon promoter (PsrfA) derived 
from the 168-strain, resulting in strain KB07. The KB07 strain sig-
nificantly increased mycosubtilin production, reaching 1045.7 ± 
12.8 mg/l (Fig. 1b).

Evaluation of hemolytic activity of surfactin and 
mycosubtilin-producing strains
We verified the hemolytic activity of surfactin- and 
mycosubtilin-producing strains on blood agar plates. In the first 
experiment, following liquid culture, KB01 and KB07 were di-
rectly inoculated onto blood agar plates. Both strains produced 
hemolytic zones on blood agar plates after 24 h of incubation 
(Fig. 2a and b). However, because colonies and hemolytic zones 
overlapped, comparing the sizes of individual colony hemolytic 
zones proved challenging. Furthermore, colony and hemolytic 
zone sizes varied because of the density of colonies on the plate.

In the following experiment, we tested the effect on colony 
and hemolytic zone development by spotting the 168-strain, 
KB01, and KB07, which were suspended in sterile water, onto 
blood agar plates. Spotting results showed that the 168-strain did 
not form a hemolytic zone, whereas hemolysis was seen around 
the colonies of the KB01 and KB07 strains (Fig. 3a). Bacillus subtilis 
colonies often have complex forms. In this study, all strains had 
noncircular colony morphologies (Fig. 3a). Therefore, manual 
measurement of colony and hemolytic zone areas is challenging. 
In this study, we used image analysis software (ImageJ) to deter-
mine the size of the colonies and hemolytic zones. In both KB01 
and KB07, the ratio of hemolytic zone area (Ha) to colony area 
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(Ca) increased with incubation time (Fig. 3b). The difference in 

the Ha/Ca ratio among the three colonies was modest for both 

strains, allowing for a consistent evaluation of the hemolytic ac-

tivity of the strains by spotting.

Effect of blood plate composition on colony 
growth and hemolytic zone formation
Based on prior publications, the blood agar plates in this study 
used glucose as a carbon source, nutrient broth, and yeast 

Figure 1. (a) Surfactin and (b) mycosubtilin production using recombinant B. subtilis strains. Error bars indicate the standard deviation of three 
independent experiments. Asterisk represents a statistically significant (p<0.01) difference in mycosbtilin titer after 72 h compared KB06 with KB07 as 
evaluated by paired comparisons using Student’s t test

Figure 2. Direct plating of the (a) KB01 and (b) KB07 strains on blood agar plates. Images were taken after incubation at 35 �C for 24 h

Figure 3. (a) Spotting of strains 168, KB01, and KB07 on blood agar plates. (b) The area ratio was calculated from the colony and hemolytic zone areas 
measured using ImageJ. For each strain, three independent colonies were selected from donor plates. Colonies were suspended in 50 ml of sterilized 
water, and 2 ml was spotted on a blood agar plate. The scale bar at the top left applies to all panels
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extract as nitrogen and other nutrient sources [7]. However, there 
are no reports on how plate composition affects the establish-
ment of hemolytic zones. Therefore, the purpose of this study 
was to explore plate composition.

Using 40 g/l glucose, 1 g/l nutrient broth, and 1 g/l yeast extract 
as the standard composition, the effects of changing these quan-
tities on hemolytic zone formation were investigated. In the stan-
dard composition, Ha/Ca ratio of KB01 and KB07 was 1.73 and 
1.92 after 72-h incubation (Fig. 4a and Supplementary Fig. S2). In 
the glucose concentration evaluation, it was found that at 4 g/l 
glucose, the plates became clear, probably due to osmotic effects, 
making it difficult to evaluate the hemolytic zones (Fig. 4a and b). 
At 100 g/l glucose, colony growth was suppressed in all strains 
(Fig. 4b and Supplementary Fig. S2). Compared to the standard 
composition plate, the 100 g/l glucose plate had similar Ha/Ca ra-
tios for KB01 (1.76) but higher values for KB07 (2.81) after 72 h in-
cubation (Supplementary Fig. S2). When the amount of nutrient 
broth was evaluated, and compared to the standard composition 
plate, colonies tended to be smaller at 0.3 g/l nutrient broth plate 
for all strains, whereas colonies tended to be larger at 10 g/l nutri-
ent broth plate with changes in colony morphology (Fig. 4c and 
Supplementary Fig. S2). KB07 had 2.0-fold larger colony sizes in 
10 g/l nutrient broth at 72 h, but the Ha/Ca ratio (1.49) was not 
significantly different from the standard composition. In con-
trast, KB01 demonstrated a 2.8-fold higher Ha/Ca ratio when 

using 10 g/l nutrient broth when compared to the standard com-

position. When the amount of yeast extract changed, the colony 

size and Ha/Ca ratio of both KB01 and KB07 strains showed al-

most identical outcomes to changes in the amount of nutrient 

broth. (Fig. 4d and Supplementary Fig. S2).

Development of a high-throughput screening 
scheme using an automation system
Spotting the strain at equal intervals increased the accuracy of 

hemolytic zone evaluation (Fig. 3a and b). However, manually 

suspending and spotting colonies is a time-consuming and labor- 

intensive procedure. Therefore, we developed a method to accu-

rately determine the hemolytic activity of a large number of colo-

nies by directly inoculating agar plates with colonies selected 

using an automatic colony picker.
The high-throughput screening method is shown in Fig. 5. 

Briefly, the strains of interest were cultured in LB medium, and 

approximately 200–500 colonies were seeded onto NY plates. 

Subsequently, 48 colonies were inoculated per plate using an au-

tomatic colony picker to avoid contact between adjacent colonies 

(Fig. 6a and b). After 48 h of incubation, the size of the colonies 

and hemolytic zones was semi-automatically measured using 

image analysis software (Supplementary Figs S3 and S4).
The average area of 48 KB01 colonies was 0.22 ± 0.04 cm2, with 

an average hemolytic zone area of 0.48 ± 0.06 cm2. The colony 

Figure 4. Spotting of strains 168, KB01, and KB07 on blood agar plates with (a) standard (40 g/l glucose, 1 g/l nutrient broth, 1 g/l yeast extract, 3 g/l 
NaCl, 15 g/l agar, and 40 ml/l defibrinated sheep blood) and modified composition. The amounts of (b) glucose, (c) nutrient broth, and (d) yeast extract 
were modified with regard to the standard composition. Colonies picked from the donor plate were suspended in 50 ml of sterilized water, and 2 ml was 
spotted on blood agar plates. The scale bar in panel (a) applies to all panels
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and hemolytic zone areas of the KB01 strain were highly corre-
lated, with a correlation coefficient of 0.92 (Fig. 6a). The mean ra-
tio of hemolytic zone area to colony area was 2.18 ± 0.15, with a 
coefficient of variation of 0.07. In the KB07 strain, the average 
area of 48 colonies was 0.91 ± 0.15 cm2, while the average hemo-
lytic zone area was 1.77 ± 0.19 cm2. The colony and hemolytic 
zone areas of the KB07 strain were highly correlated, with a cor-
relation coefficient of 0.93 (Fig. 6b). The KB07 strain had an aver-
age ratio of hemolytic zone to colony area of 1.96 ± 0.15, with a 
coefficient of variation of 0.07. A test of no correlation was con-
ducted between hemolytic zone and colony size in KB01 and 
KB07. As a result, a significant correlation was found between 
the hemolytic zone and colony size in both strains, with p<0.01. 
These findings show that the combination of colony pickers and 
image analysis software allows for the rapid and accurate evalu-
ation of the hemolytic activity of a large number of colonies.

Discussion
In this study, we investigated the procedure for inoculating bac-
terial cells onto blood agar plates, as well as the incubation pe-
riod and plate composition, to develop a high-throughput 

screening system for biosurfactant-producing strains using blood 
agar lysis methods. This study indicated that the composition of 
the plate affects the formation of colonies and hemolytic zones. 
It was suggested that even with target biosurfactants of low pro-
duction, optimizing the plate composition could make it easier to 
observe hemolytic zone. This study also revealed that direct inoc-
ulation of B. subtilis cells onto blood agar plates made evaluating 
hemolytic activity difficult because of overlapping colonies and 
hemolytic zones (Fig. 2). Furthermore, given the diverse morphol-
ogy of B. subtilis colonies, manual measurements of areas of col-
ony and hemolytic zone are difficult. While these aspects had 
not been mentioned in previous studies, they have been sug-
gested to have a significant impact on the accuracy of screening 
for highly productive strains in hemolytic activity. Therefore, in 
this study, two improvements were made to the blood agar lysis 
method to accurately evaluate hemolytic activity with high 
throughput. One involved the rearrangement of colonies using a 
colony picker, and the other was the measurement of colony and 
hemolytic zone areas through image analysis.

By rearranging the colonies, it became possible to maintain 
appropriate spacing between colonies, enabling accurate evalua-
tion of hemolytic activity. However, manual colony 

Figure 5. Scheme of high-throughput screening using blood agar lysis method with integrated colony pickers and image analysis. All the elements of 
this figure were created using PowerPoint for Mac 2019 (Microsoft, Redmond, WA, USA)

Figure 6. Inoculation of strains (a) KB01 and (b) KB07 on blood agar plates. The graph represents the colony and hemolytic zone sizes for each of the 48 
colonies, measured using ImageJ, where r denotes the correlation coefficient. Images were taken after 48 h of incubation
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rearrangement takes time. Therefore, in this study, automatic 

colony picker was applied to rearrange colonies for expediting 

the process (Fig. 5). In previous studies using the blood agar lysis 

method, Mulligan et al. [7] obtained a B. subtilis mutant with a 

3.4-fold increase in surfactin productivity through screening 1000 

colonies of UV mutants. Bouassida et al. [8] obtained B. subtilis 

mutant with over 20% increase in surfactin productivity through 

screening 300 colonies of mutants. In other screening methods, 

Zhu et al. [17] successfully obtained a B. subtilis mutant with a 3- 

fold increase in production compared to the parent strain, among 

27,000 mutants, using a color assay with polydiacetylene vesicles 

in the culture supernatant. While the time required for obtaining 

superior strains in previous screening experiments is unclear, 

the methodology demonstrated in this study could pick 4800 

colonies (48 colonies/plate) in 4 h. Owing to inconsistent inocu-

lum cell amount during colony reordering, there was variation 

in colony sizes. However, by analyzing colony and hemolytic 

zone areas using image analysis software, a correlation was ob-

served between colony size and hemolytic zone area across 48 

colonies (Fig. 6). This suggests that measuring colony and hemo-

lytic zone areas with image analysis software allows for the ac-

curate evaluation of hemolytic activity (Fig. 6a and b). 

Furthermore, as the time required for image analysis is 2–3 min 

per image, the analysis of 4800 colonies (100 plates) can be com-

pleted within a day.

Conclusions
This study revealed that to accurately evaluate hemolytic activ-

ity using the blood agar lysis method, it is necessary to ensure 

uniform alignment of colonies and precise determination of col-

ony area and hemolytic zone area through image analysis. 

Furthermore, as the composition of the medium and the incuba-

tion time significantly affect the colony area and hemolytic zone 

area, it is suggested that optimal conditions be explored based on 

the strain or type of surfactant. Although the use of the blood 

agar lysis method for screening is limited to surfactants exhibit-

ing hemolytic activity, it is believed that by considering the 

insights gained from this study, it can contribute to the accurate 

screening of strains with high productivity.
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